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Table Sorting
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Sorting data in a table puts the data in ascending or descending alphabetical or numerical order. You 
can sort tables on a single level or on multiple levels. For example, if you are sorting a list of 
customers, you might first sort by city, then by ZIP code if there are numerous ZIP codes within the 
city, and then by street. 

It is not necessary to have column headings, but it makes it easier and more meaningful if the 
columns do have headings. You can refer to the headings when sorting in Word. If you have headings, 
but don’t indicate that you do in the Sort dialog box by selecting the Header row option, Word sorts 
the column headings with the rest of the data and thus the headings won’t remain at the top of the 
columns.



Activity 04. Sorting Table Data
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Cell Merging
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Cell merging combines multiple adjacent cells into a single cell that is the size and shape of the original cells. 
You can combine cells from rows, columns, or both. 

Merging cells is useful when you want to add a title that goes across all the 
rows in a table or when you have sorted data and want the common 
information listed just once for the grouping where it applies.

If data already exists in the cells before you merge them, Word will list the 
data in the merged cell as multiple paragraphs. In the example in the 
previous figure, “Appliances” was listed in each row of the table for the 
items adjacent to the merged Appliances cell. When Word initially merged 
the cells, it listed “Appliances” eight times within the merged cell. The 
person who merged the cells then deleted all except one instance of the 
word. 

Presenter
Presentation Notes
If your table contains merged cells, you cannot sort the entire table. You can select only a portion of the table that contains unmerged cells and perform a sort on the selected cells.



Cell Splitting
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Cell splitting divides one or more cells into multiple adjacent cells. If you are splitting a single 
cell into two or more cells, you can right-click the cell and select Split Cells. If you are splitting 
multiple cells, you can do so only from the Layout contextual tab.



Cell Alignment
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The cell alignment options on the Layout contextual tab, in the Alignment group, enable you 
to position the cell contents in one of nine positions. The button images show the alignment 
positioning, such as top left, top center, top right, center left, center, center right, bottom 
left, bottom center, and bottom right.



Text Direction
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Text direction options in the Alignment group of the Layout contextual tab enable you to 
position the text horizontally or vertically in a table cell. The default is horizontal. You can 
turn it 90 degrees and flow up the left side of the cell or down the right side of the cell. 



Activity 05. Controlling Cell Layout
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Formulas in Word

11

Word is most appropriate for creating text documents, but it can also perform simple calculations. 
Word enables you to insert formulas and functions into your document so that you can perform 
calculations on numbers in the document.
A formula is a type of field code you use to perform mathematical calculations on data in a table. You 
can perform mathematical operations such as adding, subtracting, or averaging the numbers in a row 
or column. You can also enter numbers directly into the formula. By default, the formula adds the 
numbers above or to the left of the cell in which you insert the formula. 
You must always begin a formula with an equal sign, then add one of the following:
• A function (for example, SUM or AVERAGE) and arguments (ABOVE, BELOW, LEFT, specific cells, 

numbers, bookmarks, and more)
• Numbers and operators (for example, =32*.25)
• A combination of the two

Presenter
Presentation Notes
Field codes are displayed within curly braces. When you display field codes, formulas will appear inside of curly braces. For example, {=SUM(Left)}. Keep in mind that these curly braces are not part of the actual formula.



Number Format Description

#,##0 Displays whole numbers with commas to separate thousands, millions, and so on.

#,##0.00 Displays numbers with two decimal places and commas to separate thousands, 
millions, and so on.

$#,##0.00;($#,##0.00)
Displays numbers preceded by the dollar sign ($), followed by two decimal places, 
and with commas to separate thousands, millions, and so on. In addition, displays 
negative numbers in parentheses.

0 Displays whole numbers only, without commas to separate thousands, millions, and 
so on.

0% Displays decimal values as percentages.

0.00 Displays numbers with two decimal places and no comma separators.

0.00% Displays numbers as percentages with two decimal places.

Number Format
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In the Formula dialog box, you can change how the number that Word calculates with your formula is 
displayed. The Number format list provides a variety of options that can be used to specify how Word 
displays the numbers, such as formatting with dollar signs or percent signs and the number of 
decimal places to use. The following table describes the available number formats.



Formula Results
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Word doesn't automatically update the formula results when you change a number. Word 
updates the formula results when you open the document, or you can manually update the 
results. To manually update the calculation, select the field and then press F9, or right-click 
the field and then select Update field. To update all calculations in the table or document, 
select the entire table or document before you press F9.

You can also prevent Word from updating a formula. To lock a formula to prevent updates, 
select the formula and then press Ctrl+F11. To unlock the formula, select it, and then press 
Ctrl+Shift+F11.



Functions
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A function is the action that Word performs on the values in a formula. Examples of functions 
are SUM, AVERAGE, and COUNT. The functions that you can use in a formula are listed in the 
Formula dialog box under the Paste function heading. The default function is SUM, which 
adds the numbers above or to the left of the formula. 
You can delete everything from the Formula box and then enter a different function. Be sure 
to begin the formula with an equal sign. You can either type the function into the Formula 
box or select the function from the Paste function drop-down list. The examples in the table 
show some of the functions you might use.

Arguments
The arguments for a function are the entities within the parentheses following the function 
name in a formula. There are several types of arguments you can use in a function. For 
example, you can use the positional argument LEFT in the SUM function to have Word sum 
the values in all cells to the left of the cell that contains the formula. 



Argument Types
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Argument Type Description Examples

Numbers The actual value to use in the computation =SUM(3,5)

Positional arguments Computes the values of numbers to the left, 
right, above, or below the current cell

LEFT, RIGHT, ABOVE, BELOW (and combinations 
of these positions)
=PRODUCT(ABOVE,LEFT)

Bookmarks Define a bookmark for a cell and then use the 
bookmark name in the formula

(Interest_rate, LEFT) where Interest_rate is the 
bookmark name of a cell containing a number 

Cell references—RNCN RNCN references where RN refers to a row 
number and CN refers to a column number

(R2C2) Refers to the second row, second 
column in the table 

Cell references—A1 
A1 references where the first column in a 
table is A and the first row is 1 (like in a 
Microsoft® Excel® spreadsheet)

(B3) Refers to the second column, third row
(B3, C3) Refers to the second and third 
columns, third row
(B2:C4) Refers to all of the cells from the 
second column, second row, through the third 
column, fourth row
=AVERAGE(B2:B15)

• All of the functions except FALSE require arguments. Refer to the Word Help topic “Use 
a formula in a Word table” for a description of all of the functions with examples. 



Equations
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An equation is a document element for adding complex 
mathematical symbols to your document. There are several 
predefined equations that you can insert into your document. You 
can also use the equation editor to create your own equations. 

• By default, the equations are formatted in professional format. 
You can also format them in linear format.

• In Word Help, you can find additional information on creating and using equations.



Ink Equations
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Ink equations enable you to input complex formulas by writing them with your mouse or a 
stylus. You create and insert an ink equation by selecting the drop-down arrow on the 
Equation button on the Insert tab, and then selecting Ink Equation. 
As shown in the following figure, you draw your equation in the Write math here area. Word 
displays a typed equivalent in Preview here. You can use the available tools to modify the 
equation. When it's finished, select Insert to insert the formula into your document. 



Activity 06. Performing Calculations in a Table
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Create a Chart
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Charts
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A chart is a graphical interpretation of data. The information can be organized as points on a 
line, grouped into columns or bars, or shown as slices in a circle or a pie. Line and bar charts 
have a vertical and a horizontal axis with a scale showing the values on one axis and labels 
describing the data on the other axis. All types of charts should have a title. Pie charts use a 
legend to indicate what each color in the chart represents.

A chart is composed of several components. 
Some components are displayed by default, 
and others you can add if necessary. Some 
chart components can be moved, resized, or 
reformatted.



Chart Components
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Chart Component Description
Chart area The entire chart and all chart components.
Plot area The area inside the two axes where the data series are located.

Axis
There are two axes. The vertical, or y-axis, usually contains numerical data. The 
horizontal, or x-axis, usually contains categories. These can be reversed, as shown in the 
preceding figure.

Title The text that identifies or describes the chart. It can be aligned with an axis or centered 
above the chart.

Data label Labels can be added to provide additional information, such as showing the actual value 
of a bar on a bar chart inside the bar.



Chart Type Description

Column Displays data changes over a period of time or used to illustrate comparisons among values. 
Typically, the categories are displayed on the horizontal axis and the values on the vertical axis.

Line Shows trends in data over time and at equal intervals. 

Pie Shows the relative size of values in one data series, compared to the whole and to parts of the 
whole. 

Bar Displays comparisons among individual values in several categories. Similar to column charts; 
however, the categories are organized on the vertical axis and the values on the horizontal axis.

Area Shows the magnitude of change of each data category over time and illustrates the total value in a 
trend. 

XY (Scatter) Shows relationships between two categories of data in irregular intervals, or clusters. Scatter 
charts are commonly used to represent numeric values such as scientific or statistical data.

Map Displays data plotted across geographical areas, such as states or countries.

Stock Displays the change in stock prices over time or in other fluctuating sets of values over time, such 
as rainfall or temperature. 

Surface Displays three-dimensional representations of data. Finds optimal or favorable combinations 
between data sets; typically used with three sets of data.

Radar Compares the aggregate values of multiple data series. 

Chart Types
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Chart Type Description

Treemap Displays a hierarchical view of your data. Used to analyze across hierarchies and compare different 
levels of categorization. 

Sunburst
Displays hierarchical data in rings or circles with the top of the hierarchy being represented by the 
innermost ring. Sunbursts help to identify the largest contributing segments within a hierarchy of 
multiple levels.

Histogram Displays the frequencies in a distribution with columns representing bins containing values that 
can be changed. Histograms are commonly used to represent statistical data.

Box & 
Whisker

Displays the distribution of data, but it can also provide insight about distribution in a single view, 
including quartiles to show how much variation there is in a large data set, mean, and outliers. 
Useful for summarizing and comparing multiple data sets that relate to each other. 

Waterfall Displays a running total of financial data as values are added or subtracted. It is often used to 
show how an initial value is affected by a series of positive and negative values. 

Funnel Displays values across different stages of a process that are shown as a bar chart with the highest 
values at the top and the lowest values at the bottom. 

Combo Combines two or more chart types into a single display, such as a column and a line chart. Combo 
charts often include a secondary axis.

Chart Types
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The Chart in Microsoft Word Window
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When you add a chart to your Word document, the Chart in Microsoft Word window opens. 
This is an actual instance of Microsoft Excel that opens with sample data already displayed. 
You can copy data from your Word document or manually enter data in the spreadsheet to 
be graphed. By default, the Chart in Microsoft Word window has four rows and three 
columns for your data. If you paste data that doesn't consist of as many columns and/or 
rows, you must delete the extra data in order for Word to chart your data properly. When 
you close the window, the chart is added to your document at the location where your cursor 
was when you chose to insert the chart.



Contextual Chart Tabs
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After you create a chart, you can make changes to the design, layout, and format of the chart using the Chart 
Design and Format contextual tabs in Word. Select the chart to display these contextual tabs.

The Chart Design contextual tab enables you to:
• Add chart elements.
• Apply a Quick Layout.
• Select a predefined chart style.
• Switch the rows with the columns.
• Select, edit, or refresh data.
• Select a predefined chart layout.
• Change the chart type.

The Format contextual tab enables you to:
• Format the current selection.
• Reset the current selection to match the selected style.
• Insert and configure shape styles, including selecting predefined styles, shape fill, shape outline, and shape 

effects.
• Configure WordArt Styles, including adding WordArt, text fill, text outline, and text effects.
• Arrange the chart position and text wrap options.
• Specify a specific height and width for the chart.



Chart Buttons
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Button Options Description
Layout Options • In Line with Text

• With Text Wrapping
• Move with text
• Fix position on page

Choose how your chart interacts with the 
text around it.

Chart Elements • Axes
• Axis Titles
• Chart Title
• Data Labels
• Data Table
• Error Bars
• Gridlines
• Legend
• Trendline

Add, remove, or change chart elements.



Chart Buttons
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Button Options Description
Chart Styles 

• Style
• Color

Set the style and color scheme for the 
chart.

Chart Filters • Values
• Series
• Categories

• Names
• Series
• Categories

Specify which data points and names are 
included in the chart.



The Caption Dialog Box
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You might want to add a caption to your chart. This places a caption in your document above 
or below the chart. From the Caption dialog box, you can specify caption details such as the 
caption text, the type of label for the caption, and the caption location. The default label 
types do not include charts, so if you have multiple charts you would like to number and 
caption, you will want to add a new label type for charts.



Add an Excel Table to a Word Document
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Paste Button Description

Keep Source 
Formatting

Paste the Excel table into Word as a Word table. If you later change the Excel table, the Word table 
will not be updated. This option keeps the formatting you applied in Excel on the table in Word.

Use Destination Styles Paste the Excel table into a Word table and remove the formatting you applied in Excel. This option 
enables you to apply any of the Word table styles to the copy of the Excel table in Word. Note that if 
you later change the Excel table, Word will not update the Word table with your changes.

Link & Keep Source 
Formatting Link a copy of the Excel table into your Word document and keep the Excel formatting. By linking the 

table, you enable Word to update the table whenever you make changes to the Excel table.

Link & Use Destination 
Styles Link a copy of the Excel table in your Word document and remove the Excel formatting. Linking the 

table enables Word to update the contents of the table whenever you modify the Excel table.

Picture Paste a snapshot of the table as a graphic instead of a Word table. Pasting the table as a graphic 
enables you to resize and wrap text around it just like you would a photo. Any subsequent changes 
you make to the original Excel table will not be reflected in this snapshot of the table in Word.

Keep Text Only
Paste a copy of the contents of the Excel table without any table formatting in Word. Keep in mind 
that any changes you make to the Excel table will not be updated in the Word copy of it.

Excel Data Paste Options
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The Object Dialog Box
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Another option you can use to insert an Excel table into a Word document is the Object dialog box. To do so, 
select the Insert tab and, in the Text group, select Object.
In the Object dialog box: 
• Use the Create New tab to insert a new object, such as an Excel table within a Word document. 
• Use the Create from File tab to link an existing file (again, such as an Excel workbook) within a Word 

document. When the Link to file check box is checked, Word updates the inserted object whenever the 
source file is modified. 



Excel Interface in Word
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After you insert an object into a Word document, selecting that object results in Word 
displaying the interface for the type of object. For example, if you insert an Excel worksheet 
into your Word document, it appears as shown. Within the Word document, you will see an 
Excel window containing the Excel ribbon, column and row headings, and other interface 
components. 



Activity 07. Adding an Excel Table to a Word 
Document
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